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โปรแกรมโหราศาสตร 4ZSuriya 

4ZSuriya (อานวา Foresee Suriya) เปนโปรแกรมโหราศาสตรโดยใชสูตรคํานวณตําแหนงดาวใน

สุริยจักรวาลตามหลักวิทยาศาสตร จากนัน้จึงนําตําแหนงดาวที่คํานวณไดมาวิเคราะหตอตามหลัก

โหราศาสตร 

ผูที่ตองการใชโปรแกรมนี้ไมจําเปนวาตองเคยใชโปรแกรม Microsoft Excel มากอน เพียงสามารถ

ใช Excel เปดแฟมแลวกรอกวันที่ จากนั้นใชเมาสคลิกเลือกดูผลการคํานวณซึ่งแสดงออกมาใน

รูปกราฟ โดยไมจําเปนตองมีความรูดานโหราศาสตรมากอนเลยก็ได หรือถามีพ้ืนฐานเรื่องดาว 

ภพวาคืออะไรมีความหมายอยางไร ก็จะชวยทําใหใชโปรแกรม 4ZSuriya ไดสะดวกมากขึ้น 

โปรแกรม 4ZSuriya รุนลาสุดนี้เปนรุนที ่3 ใช VBA เปนเครื่องมือในการคํานวณและควบคุมการ

ทํางานทั้งหมด ดังน้ันกอนที่จะเปดแฟมใดๆขึ้นมาใน Excel เราตองปรับระบบของ Excel ให

ยินยอมให VBA ทํางานไดกอน โดยเริ่มตนจากเปดโปรแกรม Excel ขึ้นมาแลวคลกิเมนู Tools > 

Macro > Security > กาชอง Medium จากนั้นจึงใชเมนู File > Open เลือกเปดแฟม 

4ZSuriyaV3Pro+.xls หรือ 4ZSuriyaV3Pro.xls ขึ้นมาใชงาน โดยเมื่อคลิกเลือกเปดแฟม เราจะ

ถูกถามบนหนาจอวา ตองการให Macro ทํางานหรือไม ขอใหคลิกปุม Enable Macros แลวคลิก

ปุม Yes เพ่ือเลือกเปดแฟมแบบ Read Only จะไดไมตองหวงวาแฟมตนฉบับจะถกูแกไขตางไป

จากเดิมภายหลังจากเลิกใชงานเรียบรอยแลว จากนั้นบนหนาจอจะแสดงพื้นที่การใชงานตามนี ้

 

แฟม 4ZSuriyaV3Pro+.xls มี

ขนาดแฟมใหญกวา 

4ZSuriyaV3Pro.xls เน่ืองจาก

ในรุน Pro+ มีการคํานวณ 

VioCycle ซ่ึงชวยในการ

พยากรณระยะยาว 
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ความสามารถของโปรแกรม 4ZSuriyaV3Pro+.xls 

1. สามารถพยากรณตามหลักโหราศาสตรไทย โหราศาสตรสากล หรือตามหลักเกณฑอ่ืนได

ตามตองการ โดยแสดงออกมาเปนภาพที่งายตอการตีความ 

2. สามารถนําขอมูลที่คํานวณไดนําไปใชวิเคราะหตอไดทนัที 

3. แทนที่จะพยากรณทีละวันหรือทีละตําแหนง โปรแกรมน้ีสามารถพยากรณเปนชวง

ระยะเวลาหลายเดือนกอนและหลังวันทีก่ําหนด เพ่ือพยากรณแนวโนม ดูเหตุและผลที่

ตอเน่ืองตามมา ชวยทําใหเขาใจในกฎแหงกรรมไดชัดเจนมากขึ้น 

4. สามารถวิเคราะหตาํแหนงลัคนา ดาวเกษตร ประ อุจ นิจ ทักษา พักตร เสริด มณฑ และ

มุมระหวางดาว ณ วันเวลาที่ปรับเคลื่อนไปทีละวันหรอืตามชวงเวลาที่ตองการ 

5. สามารถวิเคราะหตําแหนงดาวเกษตรหรอืประแลกเรือนสลับเรือน โดยผูกความสมัพันธ

ของภพกระทบภพเปนภาพไลเหตุไปสูผลไดตลอดสาย 

6. โปรแกรมนี้ไมไดทําหนาที่เพียงแคคํานวณตําแหนงดาวและผูกลัคนาใหเทานั้น แตยัง

สามารถใหคําพยากรณออกมาไดดวย โดยใชเลขภพและเลขดาวมาแสดงเปนภาพ

ความสัมพันธระหวางกัน จึงยืดหยุนในการตีความหมาย ดีกวาโปรแกรมที่ใหคําทํานาย

เปนคําแปลเรือ่งราวที่ตายตวั 

7. ผูใชโปรแกรมไมจําเปนตองปรับเวลาใหตางไปจากที่ทราบ ขอเพียงทราบวันเวลาทีช่ัดเจน 

ตามเวลาทองถิ่นของตนซึ่งใชเวลาเดียวกนัทั้งประเทศไทย แลวกรอกลงไปในโปรแกรม 

8. โปรแกรมนี้ใชตัวแปรในการคํานวณโดยใชคาคงที่ของปค.ศ. 2000 เปนหลักและปรับแก

ไขตวัแปรอ่ืนๆใหถูกตองตามคาลาสุดเทาที่ทราบกัน จึงสามารถคํานวณตําแหนงดาว

ในชวงปที่ใกลกับค.ศ. 2000 ไดแมนยํากวาชวงเวลาที่หางจากปค.ศ. 2000 และนาจะให

ความแมนยํากวาตําแหนงดาวที่คํานวณจากโปรแกรมอื่นที่ใชกันมานาน ซ่ึงไมเคย

ปรับปรุงคาตวัแปรที่เกีย่วของในการคํานวณ (หากนําตาํแหนงดาวมาเทียบกัน จะพบวา

ตําแหนงดาวพุธและดาวศกุรคลาดเคลื่อนกันบาง) 

9. แมโปรแกรมนี้จะคํานวณตาํแหนงดาวไมแมนยําเทียบเทา NASA แตดวยความยืดหยุน

ของวิธวีิเคราะหที่ใช จะชวยใหการพยากรณทําไดอยางรอบคอบมากขึ้น โดยพยายามใช

การตีความของมนุษยที่อาจจะลําเอียงใหนอยที่สุด 

  



[3] 
 

  4ZSuriyaManual.docx  
  www.XLSiam.com
   
 

ขั้นตอนการใชโปรแกรมโหราศาสตร 4ZSuriyaV3Pro+.xls 

1. Download 4ZSuriyaV3Pro+.xls หรือ 4ZSuriyaV3Pro.xls ไดจากเว็บ 

www.XLSiam.com หรือ www.ExcelExpertTraining.com โดยใหไปที่เมนู Download 

บนเวบ็จะพบ link นําไปยังหนา Download โปรแกรมโหราศาสตร 

2. ควรปรบัหนาจอใหมีความละเอียด 1024 x 768 pixels 

3. เปดโปรแกรม Microsoft Excel 2003 (ซ่ึงถาใช Excel รุนอ่ืนอาจพบวารูปกราฟพยากรณ

บางรูปแสดงรายละเอียดไมสมบูรณ) 

4. ใชเมนูคําสั่ง Tools > Macro > Security > กาชอง Medium (ขั้นตอนนี้ทําเพียงครั้งแรก

ครั้งเดียวกอนที่จะเปดแฟมที่จะใชงาน VBA หรือ Macro เทานั้น ไมตองทําซ้ําอีก) 

5. ใชเมนูคําสั่ง File > Open เลือกเปดแฟม 4ZSuriyaV3Pro+.xls 

6. คลิกปุม Enable Macros เพ่ือยอมให VBA ในแฟมทาํงานได 

7. คลิกปุม Yes เพ่ือเปดแฟมแบบ Read Only 

8. แฟมที่เปดขึ้นมานั้นถูกกําหนดใหพยากรณดวง

ชะตาของประเทศไทย ณ วนัที่ 21 เมษายน พ.ศ. 

2325 เวลา 6 นาฬิกา 54 นาที โดยพยากรณ

เทียบกบัวันเวลาปจจุบันตอนที่เปดแฟมน้ีขึ้นใช

งาน ซ่ึงจะพบวันและเวลาบนัทึกไวในชอง

ตําแหนงที่ 1 และ 2 ตามรปู (โปรดสังเกตวาใชเครื่องหมายทับ / ในการแบงวันที่ และใช

เครื่องหมาย colon : ในการแบงชั่วโมงนาที และไมมีวรรค) 

9. สมมติวาตองการพยากรณคนที่เกิดที่จังหวัดกระบี่ ในวันที่ 

14 กุมภาพันธ พ.ศ. 2520 เวลา 4.30 น ซ่ึงเปนชวงเชา

ของวันที่ 14 น้ัน และเทียบกับดวงชะตาวันน้ี สมมติวาเปน

วันที่ 29 มกราคม พ.ศ. 2550 เวลา 11.59 น  

ในชองตําแหนงที่ 1 ในชองวันที่ใหกรอก 14/2/2520 ใน

ชองเวลาใหกรอก 4:30 และคลิกเลือกสถานที่เปน กระบี่ 

ในชองตําแหนงที่ 2 ในชองวันที่ใหกรอก 29/1/2550 ในชองเวลาใหกรอก 11:59 

10. โปรแกรมจะคํานวณใหเองในทันทีที่บันทกึเสร็จ ขอใหคลิกเมนู 4ZSuriya เพ่ือดูภาพการ

วิเคราะหและพยากรณแตละอยางตอไป 
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ขอควรระวังในการใชโปรแกรม 4ZSuriyaV3Pro+.xls 

1. เพ่ือทําใหคอมพิวเตอรทํางานไดเร็วและประหยัดหนวยความจํา ไมควรเปดแฟมอ่ืนขึ้นมา

ใชงานพรอมกับแฟม 4ZSuriyaV3Pro+.xls หรือ 4ZSuriyaV3Pro.xls 

2. ขอใหเปดแฟม 4ZSuriyaV3Pro+.xls หรือ 4ZSuriyaV3Pro.xls แบบ Read Only และเม่ือ

เลิกใชงาน ใหสั่งปดแฟมโดยไมตองสั่ง Save เพ่ือปองกันไมใหแฟมเดิมบันทึกการแกไข

ใดๆ (ควรเกบ็แฟมตนฉบับสํารองไวดวย) 

3. เพ่ือทําใหคอมพิวเตอรทํางานไดเร็ว ควรเปดแฟมที่เก็บไวใน Harddisk อยาเปดแฟมที่

เก็บไวในแผนดิสกหรือ Thumb Drive 

4. บริเวณทีส่ามารถกรอกขอมูลลงไปไดหรือสามารถคลกิเปลี่ยนขอความได จะใชสีตัวเลข

หรือสีตัวอักษรเปนสีมวงเขมบนพื้นสีออน หากทดลองกดปุม Tab ซํ้าไปเรื่อยๆ จะพบวา 

Excel จะกระโดดไปเลือกเซลลที่มีสตีัวเลขหรือสีตวัอักษรเปนสีมวงเขมบนพื้นสอีอนน้ีให

เองทีละเซลล 

5. บริเวณอื่นซ่ึงไมไดใชสีตวัเลขหรอืสีตวัอักษรเปนสีมวงเขมบนพื้นสอีอน ไดถูกปองกัน

ไมใหพิมพทับลงไปไวเรียบรอยแลว 

6. บางบริเวณที่เม่ือใชเมาสไปชี้ลอยๆเหนือคํา ปลายเมาสจะเปลี่ยนเปนรูปมือ แสดงวา

บริเวณเหลานีเ้ม่ือคลิกลงไปจะทําให

โปรแกรมทํางานพิเศษตางไปจากเดิม 

เชน ถาคลิกทีเ่ลขตําแหนงที่ 1 หรือ 2 จะ

สั่งใหใชวันเวลาปจจุบันบันทึกลงใน

ตําแหนงน้ัน ถาคลิกที่รูปตาํแหนงดาวจะ

เปดชองใหกรอกวันและเวลาใหเห็นชัด

บนหนาจอ ถาคลิกที่คําวาครั้งที่ 1 – 4 

จะคํานวณหาวันที่ดาวทํามุมกระทบ

เทากับมุมที่ตองการ ถาคลิกที่คําวา

เคลื่อนดาววงนอกครั้งละ จะสั่งใหโปรแกรมเคลื่อนตําแหนงดาวเดินหนาหรือถอยหลัง 

7. แทนที่จะใชเมนู 4ZSuriya เพ่ือไปหนาอ่ืนๆ สามารถกดปุม Ctrl+PgUp 

เพ่ือไปที่หนาตอไป หรือกด Ctrl+PgDn เพ่ือกลับมาที่หนาเดิม 
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ตัวอยางการพยากรณอยางงายโดยโปรแกรม 4ZSuriyaV3Pro+.xls 

สมมติวาเราตองการพยากรณดวงเมือง ณ เวลาปจจุบนั ซ่ึงเปนวันที ่29/1/2550 เวลา 12:00 น 

โดยคราวนี้เราจะใชเครื่องมือชวยในการบนัทึกวันที ่

1. คลิกที่รูปภาพตําแหนงดาวดานซายของจอ จะเปดหนาจอใหกรอกดังน้ี 

 
ชองชื่อ ใหพิมพคําวา Thai (สังเกตวา T ใชตวัใหญ) ซ่ึงเม่ือพิมพคําวา Thai เสร็จจะ

พบวาในชอง 1st บันทึกวันเดือนปและเวลาตกฟาก 21/4/2325 6:54 ใหเองทันทีเปน

ตําแหนงที่ 1 

2. ใหคลิกทีปุ่ม 2nd เพ่ือใชวันเดือนปและเวลาปจจุบัน 29/1/2550 12:00 ซ่ึงโปรแกรมจะ

กรอกคาใหเองทันทีเปนตําแหนงที่ 2 (ถากดปุม 1st จะบันทึกวันเวลาปจจุบันเชนกัน

เพียงแตจะบนัทึกลงในชองของตําแหนงที่ 1) 

3. จําไววา ตําแหนงที่ 1 ใชกรอกวันเวลาทีต่กฟากหรือเวลาเกิดของคนที่อยากจะถกูทํานาย 

สวนตําแหนงที่ 2 ใชกรอกวันเวลาของวนัในอดีตปจจุบันหรืออนาคตก็ได เพ่ือพยากรณวา

จะเกิดเหตุการณใดขึ้นในวนัเวลานั้น 

4. เม่ือกรอกวันเวลาครบทั้งสองตําแหนงแลวใหคลิกปุม OK เปนอันเสร็จขั้นตอนการกรอก

ขอมูล (ถาไมไดเกิดที่กรุงเทพ ใหคลิกเปลี่ยนชื่อจังหวดัในชองสถานที่ของตําแหนงที่ 1) 
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การพยากรณเหตุการณพื้นฐานชวีิตและเหตุการณปจจุบัน 

 

กราฟแทงสีแดงหรือกราฟที่มีพ้ืนสีทึบบนจอขาวดําเปนพ้ืนฐานชีวติ กราฟแทงสีขาวเปนเหตุการณ

ปจจุบัน โดยกราฟแทงสีแดงซอนอยูกับกราฟแทงสีขาวเพื่อเปรียบเทียบเหตุการณวา นาจะ

เปนไปตามพืน้ดวงเดิมหรือไม หรือจะแตกตางมากนอยเพียงใด โดยทั่วไปใหดูแทงที่มีความสงู

มากๆ เชน แทงสีแดงของเลข 9 เปนแทงที่สูงที่สุด แสดงวาพื้นดวงเมืองนั้น เปนเมืองที่มีความสุข

สงบเปนหลกั แตปจจุบันไมคอยสงบนักเพราะแทงสีขาวที่ซอนอยูเปนแทงที่ต่ํามาก 

นอกจากนั้นแทงสีขาวของเลข 2 8 10 และ 11 ยังสูงกวาแทงสีแดง แสดงวาปจจุบันมีเหตุการณใน

เรื่องรายไดรายจาย การเปลี่ยนแปลง ภารกิจ และโชคสมหวังที่คอนขางเดนชัด 

ความสูงต่ําของกราฟแทงน้ีแสดงถึงระดับความรุนแรงหรือระดับพลังในเหตุการณเรือ่งตางๆ โดย

ในทางโหราศาสตรใชคําวาภพ เริ่มจากภพที่ 1 ถึงภพที่ 12 แทนเรือ่งราวตางๆทีจ่ะพยากรณ 

เม่ือนําความสัมพันธของเหตุการณของพื้นดวงและเหตกุารณปจจุบันมาสรางเปนกราฟ Life DNA 

จะเห็นความเกี่ยวเนื่องเปนเหตุเปนผลกันชัดเจนยิ่งขึ้น 
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การวิเคราะหความสัมพันธของเหตุการณจากภาพ Life DNA 

 

กอนอ่ืนตองจําใหไดกอนวา เลขภพแตละตัวหมายถึงอะไร โดยในภาพนี้ใชหลักวาเลขภพที่นํามา

จากซายเปนเหตุ นําไปสูเลขภพดานขวาซึ่งเปนผล แลวผลที่เกิดขึ้นก็จะกลายเปนเหตุปจจัย

นําไปสูผลตอเน่ืองกันไปตามสาย 

ภาพดานซายเปนภาพ Life DNA ดาววงใน ซ่ึงใชตําแหนงดาวจากตําแหนงที่ 1 ที่กรอกลงไป 

สวนภาพดานขวาเปนภาพ Life DNA ดาววงนอก ซ่ึงใชตําแหนงดาวจากตําแหนงที่ 2 

Life DNA ดาววงใน จะคงที่ไมเปลี่ยนแปลง สวน Life DNA ดาววงนอกจะเปลี่ยนแปลงไปตามวัน

เดือนปและเวลาในอดีตปจจุบันและอนาคตที่อยากทํานาย 

จากภาพ Life DNA ดาววงใน แสดงวาดวงเมืองนั้นเลขภพที่ 9 หรือหมายถึงเหตมุงคลนั้นเปน

ตนเหตุนําไปสูภพที่ 12 > 11 ตีความไดวา ผูใหญในบานเมืองจะนําเรื่องฉับพลันมาให (12) แลว

สงผลใหเกิดเปนโชคลาภทีดี่ (11) นอกจากนั้นเรื่องฉับพลันยังนําไปสูผลดานอ่ืนๆอีกตามภพที่ 7 

6 3 2 

สวนเหตุการณปจจุบันใหดูจากภาพ Life DNA ดาววงนอกหรือภาพดานขวา ซ่ึงภาพแตกออกเปน

สองสาย สายแรกมีภพ 11 เปนเหตุนํา แสดงวาโชคสมหวังเปนเหตุ นําไปสูการตกลงรวมมือ (7) 

สวนอีกสายหนึ่งมีภพ 8 เปนเหตุนํา แสดงวาการเปลี่ยนแปลงเปนเหตุ นําไปสูเรื่องฉับพลัน (12) 

และนําไปสูเหตุมงคล (9) และสงผลกระทบมายังเจาชะตา (1) ในที่สดุ 

แนะนําใหศึกษาความหมายของภพจากตําราโหราศาสตรไทยทั่วไป จะไดตีความหมายของแตละ

ภพไดกวางขวางมากขึ้น 
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การพยากรณแนวโนมของเหตุการณ 

ใหคลิกเมนู 4ZSuriya ไปดูหนา VioCycle 

 

ใชหลักการงายๆวา เสนแนวตั้งสีแดง ซ่ึงเปนเสนประมีอยู 3 เสน แทนตําแหนงที่ไมดี โดยเสนประ

สีแดงตรงกลางตรงเลข 90 เปนตําแหนงทีไ่มดีที่สุด สวนเสนแนวตั้งสีนํ้าเงินตรงเลข 60 และ 120 

เปนตําแหนงที่ดีที่สุด สวนเสนแนวตั้งสีนํ้าเงินตรงเลข 30 และ 150 เปนตําแหนงทีดี่รองลงมา 

นอกจากนั้นขอบซายสุดตรงเลข 0 และขอบขวาสุดตรงเลข 180 ยังเปนตําแหนงทีแ่รงมากทั้งดี

และไมดี 

ในวันที่ 9/9/2549 มีการปฏิวัติ ดูไดจากเสนสีแดงทั้ง 3 เสน ถูกเสนอ่ืนๆวิ่งมาตัด 

ลองไลดูจากภาพนี้จะเห็นวาเสนสีแดงยังถูกตัดตอไปอีก มีเสนมาตัดมากนอยตางกันไป กวาเสนสี

นํ้าเงินจะเร่ิมถูกตัดเต็มที่กต็องรอถึงกลางป 2551 ไปแลว 

ภาพ VioCycle น้ีไดจากมุมกระทบของดาวทั้งหมดกวา 20 คู ทุกเสนมีเลขกํากับ เชน เสนสีเขยีว

ที่มีรูปสี่เหลี่ยมขาวหลามตดัเกาะอยู เปนเสน 7ล หมายถึงมุมกระทบระหวางดาวเสารจร (7) ที่ทํา

มุมกับลัคนา (ล) ของดวงเมืองเปนตน เสนแนวตั้งสีแดง คือ ตําแหนงทางโหราศาสตรที่เรยีกวา 

มุมเกณฑ เสนแนวตั้งสีนํ้าเงิน คือ ตําแหนงที่เรียกวา โยค หรือ ตรีโกณ 
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ขอใหพยายามทดลองใชดวงของตนเองหรือดวงของคนใกลชิด พิสูจนโปรแกรมนี้ดูวา ใชไดไหม 

หรือหาตําราโหราศาสตรทีมี่ตําแหนงดาวพรอมกับคําพยากรณมาเปรียบเทยีบกบัภาพการ

วิเคราะหในโปรแกรมนี้กันตอจะทําใหเกดิความเขาใจมากขึ้น 

ขออยายอนกลับมาขอใหผมดูดวงใหนะครับ ขอใหดูกนัเอง พิสูจนกันเอง สวนตัวผมนั้น ขณะน้ี

เชื่อแลววา โหราศาสตรน้ันมีจริง เชื่อถือได แตที่ไมคอยนาเชื่อถือ หรือเชื่อไมไดเลย ก็คือตัวหมอ

ดู เพราะหมอดูอาจดูจนเหนื่อย จําผิด คํานวณผิด แลวแปลความหมายอยางผิดๆตอ 

นอกจากนั้น ดวงดาวเปนเพียงเครื่องมือหน่ึงที่จะบอกใหเราทราบวา ประตูจะเปดเม่ือใด ถาทําดี 

แลวประตูเปด ก็จะไดรับผลดีตามกรรมดีที่ทําไว ถาทําชั่วก็ถึงเวลารบับาปกรรม ถาตนไมเคยสราง

กรรมดี ไมเคยทําบุญมากอน อยาหวังเลยวา ดวงที่บอกวาดีแสนดี ดวงดาวจะชวยใหชีวตินี้มี

ความสุขความเจริญ  

สวนคนทีส่รางแตกรรมดีมาตลอด ไมตองดูดวงเลยก็ได เพราะเม่ือดวงดาวบอกวา ถึงเวลาแลวที่

ประตูแหงบาปเคราะหจะเปด แตดวยผลบุญทีต่นทําไว จะชวยสงเคราะห ปกปอง บรรเทา ใหราย

ไมสงผล หรือแกรายกลายเปนดี 

คนที่ทําแตดี คิดดีน้ัน ตกน้ําไมไหล ตกไฟไมไหม 

หากมีขอสงสัยในวธิีใชโปรแกรมหรืออยากซักถามวิธแีปลความหมาย ขอใหถามไดที่ฟอรัม 

http://www.excelexperttraining.com/forum/viewforum.php?f=13 
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